
Setting Up Your Development Environment
ONAP Developer Set-Up
Follow the steps below to set up the development environment on your client machine, and to establish credentials with which you may access the 
repositories.

ONAP Developer Set-Up
Create a Linux Foundation Account
Basic Setup
Git
Java
Maven

Proxy settings for Maven (if required)
OS Specific Instructions

MAC/OSX (in review under 10.15.7)
Redhat/CentOS (in review under RHEL 8.3)
Ubuntu (in review under 20.04 )
SSH Connection (Recommended)
HTTPS Connection
Proxy setting for IntelliJ and Git (if required)

IDEs
Eclipse

Install Eclipse
ONAP Eclipse Java Formatter
Install useful plugins for Eclipse
Set up Sonar towards ONAP for Eclipse
Setting up the ONAP Checkstyle for Eclipse
Spread blueprint to other projects for Eclipse
Configure ONAP copyright for Eclipse

IntelliJ
Download & Install
Configure ONAP code CheckStyle Plugin for IntelliJ
Configure ONAP code style auto formatting for IntelliJ (using the same checkstyle rules and automating it for you )
Configure ONAP copyright for IntelliJ
Set up SonarLint towards ONAP for IntelliJ

Optional Tools & Utilities
Python
git-review (optional)
Node-JS
Local SonarQube Setup
Other Optional Tools

Troubleshooting & Know Issues
Windows Limitations
Hack oparent to fix "curly bracket" issue

Appendix

Create a Linux Foundation Account

Follow the instructions on the identity portal to create a Linux Foundation account and get access to the ONAP Gerrit instance.

Verify that you can log in at https://gerrit.onap.org/ and that you can see the ONAP list of repositories.

Basic Setup

Git

Install git for your OS in accordance with https://www.atlassian.com/git/tutorials/install-git

Since this is common for all OS, we will also use it to generate our SSH keys as well :

ssh-keygen

This should generate a private and public ssh key.

The public ssh key can then be uploaded to Gerrit (user setting, ssh keys, add new key) or elsewhere as needed for authorization.

Java

ONAP is moving to Java 11 but many projects still use Java 8.

https://identity.linuxfoundation.org/
https://gerrit.onap.org/
https://www.atlassian.com/git/tutorials/install-git#windows


Download and install the appropriate openjdk version in accordance with the component you are working and set JAVA_HOME environment variable to 
point to that

Maven

Download the latest Maven using installer from https://maven.apache.org/download.cgi

Add maven to your path variable.

To test the new installation run:

mvn -version

Use the settings.xml found in the oparent repo

Save this Maven settings.xml as your ~/.m2/settings.xml (windows c:\users\<username>\.m2)

WSL users can point to one common repo across Windows and Ubuntu as :

ln -s /mnt/c/Users/<username>/.m2 ~

Proxy settings for Maven (if required)

If you are behind a proxy you can add a proxy section to your settings.xml 

Proxy Settings

        <proxies>
        <proxy>
            <id>evil-corp-http</id>
            <active>true</active>
            <protocol>http</protocol>
            <host>proxy.evil-corp.com</host>
            <port>599</port>
            <nonProxyHosts>localhost|127.0.0.1|*.evil-corp.com|*.happy.evil-corp.com|fun.evil-corp.com<
/nonProxyHosts>
        </proxy>
        <proxy>
            <id>evil-corp-https</id>
            <active>true</active>
            <protocol>https</protocol>
            <host>proxy.evil-corp.com</host>
            <port>599</port>
            <nonProxyHosts>localhost|127.0.0.1|*.evil-corp.com|*.happy.evil-corp.com|fun.evil-corp.com<
/nonProxyHosts>
        </proxy>
        </proxies>

OS Specific Instructions

MAC/OSX  (in review under 10.15.7)
get your MBP 2020 16 inch   - refer to ready for development http://wiki.obrienlabs.cloud/display/DEV/Developer+Guide#DeveloperGuide-OSX

Install homebrew package manager - 

/usr/bin/ruby -e "$(curl -fsSL https://raw.githubusercontent.com/Homebrew/install/master/install)"

python should already be installed. - do a   check--version

install openstack tools

install docker (dmg) - https://docs.docker.com/docker-for-mac/install/#download-docker-for-mac

Redhat/CentOS (in review under RHEL 8.3)

https://openjdk.java.net/install/
https://maven.apache.org/download.cgi
https://git.onap.org/oparent/plain/settings.xml
http://eclipsejpa.blogspot.ca/2017/03/optimizing-your-macbook-pro-15-2016-for.html
http://wiki.obrienlabs.cloud/display/DEV/Developer+Guide#DeveloperGuide-OSX
https://docs.docker.com/docker-for-mac/install/#download-docker-for-mac


Add the following option to your MAVEN_OPTS in order not to 
periodically hang on downloading artifacts in linux

-Djava.net.preferIPv4Stack=true

enable IP4 forwarding to enable the RHEL VM to act as an 
edge router - without this docker containers cannot communicate

add to /etc/sysctl.conf
net.ipv4.ip_forward = 1

Install docker (required for some repos like  off dcae-inventory
dcae

to install kubernetes follow Cloud Native 
Deployment#Scriptedundercloud(Helm/Kubernetes/Docker)
andONAPinstall-SingleVM

Ubuntu (in review under 20.04 )

enable ubuntu desktop apt-get update

apt-get install ubuntu-desktop

enable static IP vi /etc/network/interfaces

add

iface enp0s25 inet static

address 192.168.15.101

netmask 255.255.255.0

network 192.168.15.0

broadcast 192.168.15.255

gateway 192.168.15.1

dns-nameservers 8.8.4.4

disable strict host checking (client and server) in ~/.ssh/config

Host *
   StrictHostKeyChecking no
   UserKnownHostsFile=/dev/null

Enable non CD repositories so an apt-get update will work comment out the CD first line in /etc/apt/sources.list

enable ssh if skipped during installation so we can remote ssh sudo apt-get install openssh-server

http://java.net/
https://docs.docker.com/engine/installation/linux/centos/#install-using-the-repository


enable root login and gui (no sudo su -) sudo passwd root

sudo usermod -U root

sudo reboot now

sudo vi /etc/lightdm/lightdm.conf

[SeatDefaults]

greeter-session=unity-greeter

user-session=ubuntu

greeter-show-manual-login=true

: enable root login

vi /etc/ssh/sshd_config

FROM:
PermitRootLogin prohibit-password
TO:
PermitRootLogin yes

systemctl restart sshd

Add the following option to your MAVEN_OPTS in order not to periodically hang on 
downloading artifacts in linux

in /etc/environment

-Djava.net.preferIPv4Stack=true

Install docker (required when building docker images) use the current as of 20180621 17.03 version in the script
https://git.onap.org/logging-analytics/tree/deploy/rancher
/oom_rancher_setup.sh
which is

curl https://releases.rancher.com/install-
docker/17.03.sh | sh

Connecting to ONAP Gerrit

SSH Connection (Recommended)

Log in to the Gerrit host  , pull down the menu under your user name (at the extreme top right of the browser window), click on https://gerrit.onap.org/
"Settings":

Click your account name on the top right corner of the website and click on  .Settings

Add the public ssh key that you created in the previous step.

HTTPS Connection
If you choose to use HTTP/HTTPS, you'll need to generate an access password. Log in to the Gerrit host  , pull down the menu under https://gerrit.onap.org/
your user name (at the extreme top right of the browser window), click on "Settings", and select "HTTP Password"

This password may have a limited time to live, so you might get errors like this one:

Problem running 'git remote update gerrit'
Fetching gerrit
fatal: unable to access '  ': Unknown SSL protocol error in https://USERNAME@gerrit.onap.org/r/a/mso/
connection to :443 error: Could not fetch gerrit gerrit.onap.org

Regenerating a password will most likely solve the connectivity issue. Sometimes, the Gerrit interface on HTTPS might be temporarily faulty, so retries 
might be needed.

Proxy setting for IntelliJ and Git (if required)
For developers working with a proxy, you might have proxy issues connecting to Linux Foundation website. To avoid the connection issue, you must define 
the proxy setting for both IntelliJ and Git.

To configure the proxy settings in IntelliJ;

http://java.net/
https://docs.docker.com/engine/installation/linux/centos/#install-using-the-repository
https://git.onap.org/logging-analytics/tree/deploy/rancher/oom_rancher_setup.sh
https://git.onap.org/logging-analytics/tree/deploy/rancher/oom_rancher_setup.sh
https://gerrit.onap.org/
https://gerrit.onap.org/
https://USERNAME@gerrit.onap.org/r/a/mso/
https://gerrit.onap.org/


click   ->   ->   ->   -> File Settings Appearance & Behavior System Settings HTTP Proxy

 enter the correct proxy settings and click  .Apply

In case of  , while entering the  , there is no need to write   in front of the URL. For example, if the proxy value Manual proxy configuration Host name http://
is  , you would put   as the http://one.proxy.com one.proxy.com Host name

To configure the proxy settings for Git, play the following command:

git config --global https.proxy https://<proxy username>:<proxy password>@<proxy url> 

git config --global http.proxy http://<proxy username>:<proxy password>@<proxy url>

Note: while entering the proxy username, sometimes it may require to add the domain name in front.

IDEs

Eclipse

Install Eclipse

Download and run the installer from:  Select "Eclipse IDE for Java Developers" to install.Install Eclipse.

ONAP Eclipse Java Formatter 

Download   and import into Eclipse. onap-java-formatter.xml

(updates to the settings should be committed and merged back into the repository)

ONAP uses Google Java Style with some modifications. ( See   )Java code style

Using the Eclipse Formatter file above and maven plugin configuration in pom.xml as per  pom.xml

(  for Eclipse formatter and   for import order)https://code.revelc.net/formatter-maven-plugin/ https://github.com/diffplug/spotless/tree/master/plugin-maven

http://one.proxy.com
http://one.proxy.com
https://www.eclipse.org/downloads/packages/installer
https://www.eclipse.org/downloads/packages/installer
https://gerrit.onap.org/r/gitweb?p=aai/aai-common.git;a=blob_plain;f=onap-java-formatter.xml;hb=HEAD
https://google.github.io/styleguide/javaguide.html
https://wiki.onap.org/display/DW/Java+code+style
https://gerrit.onap.org/r/gitweb?p=aai/aai-common.git;a=blob_plain;f=pom.xml;hb=refs/heads/master
https://code.revelc.net/formatter-maven-plugin/
https://github.com/diffplug/spotless/tree/master/plugin-maven
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Example pom.xml configuration

            <plugins>
                <!--
                Using https://code.revelc.net/formatter-maven-plugin/ for Eclipse formatter
                Using https://github.com/diffplug/spotless/tree/master/plugin-maven for import order
                Use in combination to rewrite code and imports, then checkstyle
                
                mvn formatter:format spotless:apply process-sources
                -->
                <plugin>
                     <groupId>net.revelc.code.formatter</groupId>
                     <artifactId>formatter-maven-plugin</artifactId>
                     <version>2.8.1</version>
                     <configuration>
                        <configFile>${project.parent.basedir}/onap-java-formatter.xml</configFile>
                     </configuration>
                     <!-- https://code.revelc.net/formatter-maven-plugin/
                          use mvn formatter:format to rewrite source files
                          use mvn formatter:validate to validate source files -->
                 </plugin>
                <plugin>
                  <groupId>com.diffplug.spotless</groupId>
                  <artifactId>spotless-maven-plugin</artifactId>
                  <version>1.18.0</version>
                  <configuration>
                    <java>
                     <importOrder>
                       <order>com,java,javax,org</order>
                     </importOrder>
                    </java>
                  </configuration>
                <!-- https://github.com/diffplug/spotless/tree/master/plugin-maven
                     use mvn spotless:apply to rewrite source files
                     use mvn spotless:check to validate source files -->
                </plugin>
            </plugins>

The combination can be used in a maven command to rewrite code and imports, then checkstyle audit like so

Example maven command

mvn formatter:format spotless:apply process-sources

Install useful plugins for Eclipse

Install  for code coverage and  for static code analysis.EclEmma SonarLint

Set up Sonar towards ONAP for Eclipse

To bind your projects to the ONAP Sonar server, follow the instructions below.

Your projects should be imported in to Eclipse before this.

Right click on the project and select "SonarLint -> Bind to SonarQube or SonarCloud...".
Select "sonarcloud" and press "Next".
Click "Generate Token"
A browser opens and you are taken to a Sonarcloud login page
Login with an appropriate account from the list presented, most likely your GitHub account
You are now directed to a sonarcloud token generation page
Enter a name for your token and click "Generate"
Copy the token hex string that is generated from the browser and paste it into the "Token" field in Eclipse and click "Next"
In the "Organization" field, enter the string "onap" and press "Next"
The Connection name "SonarCloud/onap" should be found by the system, click "Next"
The connection should be successfully created, click "Finish"
Press "Add...".

https://www.eclemma.org/installation.html
https://www.sonarlint.org/eclipse/
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Select the projects you want to add and press "OK".
Press "Next".
Start typing the name of your project, and it should appear in a list box where it should be selected.
Press "Finish".

To see messages from Sonar introduced by edits made in the projects, select "Window -> Show View -> Other...". Expand "SonarLint" and select 
"SonarLint -> On-The-Fly".

Setting up the ONAP Checkstyle for Eclipse

Set "ONAP" configuration in Eclipse

To set the newly built checkstyle files in Eclipse:

Preferences->Checkstyle
Click "New"
Select "External Configuration File"
Give it a name eg ONAP
Point at the file <your_git_folder>/oparent/checkstyle/src/main/resources/onap-checkstyle/onap-java-style.xml  
(assuming you have downloaded the  repo)oparent
Click OK
Select "ONAP" configuration and click "Set as Default"
Select "Apply and Close"

Apply "ONAP" configuration to a project in Eclipse

Now we need to activate the checkstyle on one project and set it as the blueprint for all of them:

Select a project in eclipse and right click->PropertiesCheckstyle
check "Checkstyle active for this project"
Select the "ONAP" checkstyle profile
Click "Apply and Close"

Spread  to other projects for Eclipseblueprint

Now spread the profile to all other projects:

Select all the projects you want to apply the profile to in the Eclipse project explorer (not the one that you set up above)
Right click->Checkstyle->Configure projects from blueprint
Select the project you set up above
Now all the projects have the correct checkstyle setup.

Configure ONAP copyright for Eclipse

Window > Preferences
Java > Code Style > Code Templates
Click Code and select New Java files
Click Edit
Paste the license below
Click Insert Variable and add the date
Add the organization name
Click Apply

============LICENSE_START=======================================================
 Copyright (C) $today.year <organization name>
 ================================================================================
 Licensed under the Apache License, Version 2.0 (the "License");
 you may not use this file except in compliance with the License.
 You may obtain a copy of the License at
  
       http://www.apache.org/licenses/LICENSE-2.0
 Unless required by applicable law or agreed to in writing, software
 distributed under the License is distributed on an "AS IS" BASIS,
 WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.
 See the License for the specific language governing permissions and
 limitations under the License.
  
 SPDX-License-Identifier: Apache-2.0
 ============LICENSE_END=========================================================

IntelliJ

Download & Install
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see https://www.jetbrains.com/idea/download/#section=windows

Make sure you have added the Checkstyle plugin . Follow the below link

https://plugins.jetbrains.com/plugin/1065-checkstyle-idea

Configure ONAP code CheckStyle Plugin for IntelliJ

Select, File, Settings, Tools, Checkstyle  
Click on + beside the 'Configuration File' box to add a configuration
Set description to something like 'ONAP Rules'
Click on Browse to select the file <your_git_folder>/oparent/checkstyle/src/main/resources/onap-checkstyle/onap-java-style.xml  
(assuming you have downloaded the repo) oparent 
Complete the Wizard (you can set exclusion properties if needed)
Select the Configuration File you just added by selecting the relevant checkbox
Click [OK] to close the settings popup

Configure ONAP code style auto formatting for IntelliJ (using the same checkstyle rules and automating it for you  )

Select, File, Settings, Editor, Code Style
Click on the gear icon at the end of the line for "Scheme:"
Optional: As importing a schema overrides the current scheme you might want to first use the 'Duplicate..' and  'Rename...' options to create an 
easily identifiable scheme e.g. 'ONAP Standard'
Import SchemeCheckstyle Configuration
Click on Browse to select the file <your_git_folder>/oparent/checkstyle/src/main/resources/onap-checkstyle/onap-java-style.xml  
(assuming you have downloaded the repo) oparent 
Click OK

Configure ONAP copyright for IntelliJ

File > Settings > Editor > Copyright > Copyright Profiles
Click the + icon and add the copyright text below
Change the organization name
Go to the Copyright
Select the new copyright profile from the drop down for Default project copyright
Click Apply

============LICENSE_START=======================================================
 Copyright (C) $today.year <organization name>
 ================================================================================
 Licensed under the Apache License, Version 2.0 (the "License");
 you may not use this file except in compliance with the License.
 You may obtain a copy of the License at
  
       http://www.apache.org/licenses/LICENSE-2.0
 Unless required by applicable law or agreed to in writing, software
 distributed under the License is distributed on an "AS IS" BASIS,
 WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.
 See the License for the specific language governing permissions and
 limitations under the License.

  
 SPDX-License-Identifier: Apache-2.0
 ============LICENSE_END=========================================================

Set up SonarLint towards ONAP for IntelliJ

Prerequisites

You need to be part of the in GitHub (see GitHub, click on your icon and select 'My Organizations') onap organization 
If you are not a member of this organization email    and ask to be added to the in GitHubsupport.linuxfoundation.org  onap organization 

. It is possible to enter a different organization if you at least member of 1 organization (you can create your own in GitHub).Note
The plugin wizard crashes if you are member of no organization at all, see this Bug: https://jira.sonarsource.com/browse/SLI-426
Make sure you have added the SonarLint plugin

To use SonarLint with Onap projects you need to setup a connection with SonarCloud

Select, File, Settings, Tools, SonarLint.
Click on + beside the 'SonarCube / SonarClod connections' box to add a new connection
Set Configuration Name to something like 'ONAP'
Ensure is selected  and click [Next] sonarcloud 
Click [Create Token]
Select GitHub, logon and follow the GitHub wizard to create a Token
Copy Token into IntelliJ wizard
Click [Next] (might have to wait a little while your data is being downloaded)
Select 'Open Network Automation Platform (ONAP)' from 'Your Organizations' and click [Next]
Click [Finish] to close the wizard

https://www.jetbrains.com/idea/download/#section=windows
https://plugins.jetbrains.com/plugin/1065-checkstyle-idea
http://www.apache.org/licenses/LICENSE-2.0
https://github.com/onap
http://support.linuxfoundation.org/
https://github.com/onap
https://jira.sonarsource.com/browse/SLI-426
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Click [OK] to leave settings

Then you need to bind each project to the corresponding project in GitHub/SonarCloud:

Select, File, Settings, Tools, SonarLint, Project Settings
Enable (check) 'Bind project to SonarQube / SonarCloud'
Select the connection created above using the [Configure the connection] button
Enter the project name (e.g. 'onap_ccsdk-sli-plugins') or select it using [Search in list..] 
Start typing the name of your project, and it should appear in a list box where it should be selected.
Click [OK] to finish

Optional Tools & Utilities

Python

Download Python from https://www.python.org/downloads/

Add python binary to Path.

Install "pip3", if you plan to use git-review.

sudo apt-get update

sudo apt-get -y install python3-pip

pip3 --version

git-review (optional)

In a shell, type the following command (assumes you installed python above) :  

pip3 install git-review

To use  , you have to be in a Git clone directory that already contains a (possibly hidden)   configuration file (see git review .gitreview Gerrit/Advanced 
)usage#Setting up a repository for git-remote

Configure Git to remember your Linux Foundation user name and email address (the user name and email address associated with your Linux Foundation 
login):

git config --global user.email <your_LF_account_email>

git config --global --add gitreview.username <your_LF_user_name>

Configure git review

git config --global gitreview.remote origin

If you are using VPN, you might encounter a proxy problem while connecting to the Linux Foundation website. To avoid the problem, you should add the 
proxy setting in git config, using the following command:

Check which version of python your project is using before installing. 

The Git and git-review installation steps above are derived from the description at:   https://www.mediawiki.org/wiki/Gerrit/git-review#Windows

https://www.python.org/downloads/
https://www.mediawiki.org/wiki/Gerrit/Advanced_usage#Setting_up_a_repository_for_git-remote
https://www.mediawiki.org/wiki/Gerrit/Advanced_usage#Setting_up_a_repository_for_git-remote
https://www.mediawiki.org/wiki/Gerrit/git-review#Windows
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git config --global https.proxy https://<proxy username>:<proxy password>@<proxy url> 

git config --global http.proxy http://<proxy username>:<proxy password>@<proxy url>

NOTE: When entering the proxy username, you might be required to add the domain name in front of the username.

Node-JS

The dcae build will install npm in most cases.

However you can install it yourself from https://nodejs.org/en/download/

Verify your installation by 

npm -v

Local SonarQube Setup

It can be useful to have SonarQube running locally rather than pushing through CI for feedback.

This can be done using docker:

Images of the Community, Developer, and Enterprise Editions are available on .Docker Hub

Start the server by running:

$ docker run -d --name sonarqube -p 9000:9000 sonarqube:latest

Log in to  with System Administrator credentials (login=admin, password=admin).http://localhost:9000
Click the  button to analyze your first project.Create new project

Other Optional Tools

The component you are working on may require additional tool installations, see the relevant section under  .Development Guides

Troubleshooting & Know Issues

Windows Limitations

Some repos might not clone in Windows until some file paths are reduced below 255 chars.

Enable long paths in windows as

git config --system core.longpaths true

Hack oparent to fix "curly bracket" issue
The first issue is that the current ONAP master tagged version of the checkstyle does not work with Eclipse Oxygen/Photon (and maybe other versions) 
because of the "curly bracket" issue. There is a fix on the way but it's not here yet. The current tagged version of oparent we are using in Policy is 1.2.1.

To get around this issue, check out oparent, checked out the 1.2.1 tag, fixed the "curly bracket" bug and built it on my local machine.

Check out oparent
git tag -l
git co tags/1.2.3 -b 1.2.3
If you want CheckStyle to ignore generated files, do the following:

Add the following tag to the above file:
<module name="SuppressionFilter">
  <property name="file" value="<absolute path to the directory of the file>/suppressions.xml"/>
</module>
Create a file called "suppressions.xml" in the folder given above, and put the following content in it:
<?xml version="1.0"?>
<!DOCTYPE suppressions PUBLIC
  "-//Checkstyle//DTD SuppressionFilter Configuration 1.2//EN"
  " ">https://checkstyle.org/dtds/suppressions_1_2.dtd
<suppressions>

https://nodejs.org/en/download/
https://hub.docker.com/_/sonarqube/
http://localhost:9000
https://wiki.onap.org/display/DW/Development+Guides
https://checkstyle.org/dtds/suppressions_1_2.dtd
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  <suppress files="[\\/]generated-sources[\\/]" checks="[a-zA-Z0-9]*"/>
</suppressions>

The versions in the POMs in oparent are snapshot, so we need to change those to 1.2.1
 mvn versions:set -DnewVersion=1.2.1
Now build locally:
mvn clean install

Appendix

Building Entire ONAP

https://wiki.onap.org/display/DW/Building+Entire+ONAP
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